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About This Manual

Aspen Plus is a powerful tool that allows you to easily model petroleum processes.
Using this book, you will learn the basics of how to build and run a process model
of a simplified crude fractionation train. After completing the five sessions in this
guide, you will be able to perform basic simulations of petroleum processes.

This manual assumes you have:
• Installed the Aspen Plus Simulation Engine and User Interface
• Completed the tutorial sessions in Getting Started Building and Running a

Process Model, so that you are familiar with the basics of how to use Aspen
Plus

Modeling Petroleum Processes with
Aspen Plus

Petroleum refining processes are highly complex and integrated. They have unique
characteristics that set them apart from other chemical processes, including:
• Process feedstocks, which consist of complex and wide-boiling mixtures of

hydrocarbons, whose exact compositions are unknown
• Highly-coupled and heat-integrated fractionation units, used to separate

feedstocks into a variety of products with different specifications
• Open steam and cooling water for stripping and heat recovery, giving rise to

the presence of two liquid phases throughout the refining process
• Degree of separation specified in terms of distillation temperatures, gaps,

overlaps, and other properties
• Product specifications given in terms of stream properties such as flash point,

pour point, sulfur content, metal contents, and octane number
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Aspen Plus provides special features to handle the unique characteristics of
petroleum refining applications. With Aspen Plus, you can develop a simulation
model of your petroleum process, then use this model to study alternative modes
of operation or optimize the existing operation.

This manual guides you through some of the key petroleum features in Aspen
Plus. You can use these features with the wide range of other Aspen Plus
capabilities, such as estimating and regressing physical properties, fitting plant
data to simulation models, and optimizing your process.

Sessions in this Book

This book guides you in building a flowsheet that describes a crude fractionation
train in a petroleum refinery. Each chapter contains a tutorial session that builds
one block of the flowsheet. You can complete the entire flowsheet by following each
chapter in succession.

This book includes the following hands-on sessions:

Complete this chapter To learn how to

1  Blending Crude and Petroleum Fractions Define components, enter assay data for two crude oils, and blend the
crude oils into a single process feed.

2  Adding a Preflash Tower Model a preflash tower.

3  Adding an Atmospheric Crude Distillation Unit Model a crude atmospheric unit.

4  Adding a Vacuum Unit Model a vacuum unit.

5 Displaying Petroleum Properties Use petroleum properties with your simulation model to obtain more
information about the process.

Using Backup Files
We recommend that you perform all sessions sequentially in order to build the
entire model. However, you can skip chapters and work on the session of your
choice, using backup files containing simulation data.

Aspen Plus provides backup files containing all problem specifications and results
for each tutorial session. If you skip a session, you might need to load a backup
file to supply missing data. The chapter describes how to do this. If you perform
each tutorial session in order, you can use backup files to compare your results.
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For More Information
Online Help  Aspen Plus has a complete system of online help and
context-sensitive prompts. The help system contains both context-sensitive help
and reference information. For more information about using Aspen Plus help,
see the Aspen Plus User Guide, Chapter 3.

Aspen Plus Getting Started Building and Running a Process Model  This
tutorial includes several hands-on sessions to familiarize you with Aspen Plus.
The guide takes you step-by-step to learn the full power and scope of Aspen Plus.

Aspen Plus Getting Started Modeling Processes with Electrolytes  This
tutorial includes several hands-on sessions to familiarize you with simulating
electrolyte systems with Aspen Plus.

Aspen Plus Getting Started Modeling Petroleum Processes  This tutorial
includes several hands-on sessions to familiarize you with simulating petroleum
processes with Aspen Plus.

Aspen Plus Getting Started Customizing Unit Operation Models  This
tutorial includes several hands-on sessions to familiarize you with the
customization of unit operation models with Aspen Plus.

Aspen Plus User Guide  The three-volume Aspen Plus User Guide provides
step-by-step procedures for developing and using an Aspen Plus process
simulation model. The guide is task-oriented to help you accomplish the
engineering work you need to do, using the powerful capabilities of Aspen Plus.

Aspen Plus reference manual series  Aspen Plus reference manuals provide
detailed technical reference information. These manuals include background
information about the unit operation models and the physical properties methods
and models available in Aspen Plus, tables of Aspen Plus databank parameters,
group contribution method functional groups, and a wide range of other reference
information. The set comprises:
• Unit Operation Models
• Physical Property Methods and Models
• Physical Property Data
• User Models
• System Management
• System Administration
• Summary File Toolkit

Aspen Plus application examples  A suite of sample online Aspen Plus
simulations illustrating specific processes is delivered with Aspen Plus.
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Aspen Plus Installation Guides   These guides provide instructions on
platform and network installation of Aspen Plus. The set comprises:
• Aspen Plus Installation Guide for Windows
• Aspen Plus Installation Guide for OpenVMS
• Aspen Plus Installation Guide for UNIX

The Aspen Plus manuals are delivered in Adobe portable document format (PDF)
on the Aspen Plus Documentation CD.

Technical Support
World Wide Web  For additional information about AspenTech products and
services, check the AspenTech World Wide Web home page on the Internet at:

http://www.aspentech.com/

Technical resources  To obtain in-depth technical support information on the
Internet, visit the Technical Support homepage. Register at:

http://www.aspentech.com/ts/

Approximately three days after registering, you will receive a confirmation e-mail
and you will then be able to access this information.

The most current Hotline contact information is listed. Other information
includes:
• Frequently asked questions
• Product training courses
• Technical tips
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AspenTech Hotline  If you need help from an AspenTech Customer Support
engineer, contact our Hotline for any of the following locations:

If you are located in: Phone Number Fax Number E-Mail Address

North America & the
Caribbean

+1-617/949-1021

+1-888/996-7001
     (toll free)

+1-617/949-1724 support@aspentech.com

South America
   (Argentina office)

   (Brazil office)

+54-11/4393-5308

+55-11/5506-0756

+54-11/4394-8621

+55-11/5506-0567

tecnoba@aspentech.com

tecnosp@aspentech.com

Europe, Gulf Region, & Africa
   (Brussels office)

   (UK office)

+32-2/724-0100

+44-1223/312220

+32-2/705-4034

+44-1223/366980

atesupport@aspentech.com

Japan +81-3/3262-1743 +81-3/3262-1744 atjsupport@aspentech.com

Asia & Australia

   (Hong Kong office)

   (Korea office)

+85-2/2838-6077

+82-2/761-5800

+85-2/2833-5642

+82-2/761-5803

atasupport@aspentech.com

❖    ❖    ❖    ❖
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1 Blending Crude and
Petroleum Fractions

This tutorial contains five sessions to guide you through the process of building a
model of a crude fractionation train typically found in a petroleum refinery.

In this first session, you will begin to build the model by defining the crude feed
to the process, using the Aspen Plus Assay Data Analysis Run Type. You will use
this run type to analyze petroleum crudes before running a flowsheet simulation.

In this session you will:

• Define components
• Enter assay data for two crude oils
• Blend the crude oils to produce the crude feed
• Generate pseudocomponents for the blend
• Run the Assay Data Analysis calculations
• Examine results

Allow about 45 minutes to complete this session.
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Petroleum Process Flowsheet
The following illustration shows the petroleum process flowsheet you will work
with throughout this book:

Problem Definition: Crude Fractionation Train

The process consists of the following steps:
1. The process feed (MIXCRUDE), consisting of a blend of two crude oils (OIL-1,

see Table 1.1; OIL-2, see Table 1.2), goes to the preflash furnace.

2. The preflash tower (PREFLASH) removes light gases and some naphtha from
the partially vaporized feed.

3. Preflash bottoms (CDU-FEED) are further processed in the crude distillation
unit (CDU). The CDU consists of a crude unit furnace and an atmospheric
tower. First, the crude unit furnace partially vaporizes the bottoms from the
preflash. Then the atmospheric tower separates the preflash bottoms into five
cuts:

− Heavy naphtha (HNAPHTHA)
− Kerosene (KEROSENE)
− Diesel (DIESEL)
− Atmospheric gas oil (AGO)
− Reduced crude (RED-CRD)

4. Reduced crude goes to the vacuum distillation unit (VDU) for further
fractionation under vacuum conditions. The VDU consists of a vacuum unit
furnace and vacuum tower. The vacuum tower produces the following
additional cuts:
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− Overhead (OFF-GAS)
− Light vacuum gas oil (LVGO)
− Heavy vacuum gas oil (HVGO)
− Asphaltic residue (RESIDUE)

Table 1.1 OIL-1: (API = 31.4)

TBP Distillation Light Ends Analysis API Gravity Curve

Liq. Vol. % Temperature (F) Component Liq. Vol. Frac. Mid. Vol. % Gravity

6.8 130.0 Methane 0.001 5.0 90.0

10.0 180.0 Ethane 0.0015 10.0 68.0

30.0 418.0 Propane 0.009 15.0 59.7

50.0 650.0 Isobutane 0.004 20.0 52.0

62.0 800.0 N-Butane 0.016 30.0 42.0

70.0 903.0 2-Methyl-Butane 0.012 40.0 35.0

76.0 1000.0 N-Pentane 0.017 45.0 32.0

90.0 1255.0 50.0 28.5

60.0 23.0

70.0 18.0

80.0 13.5

Table 1.2 OIL-2: (API = 34.8)

TBP Distillation Light Ends Analysis API Gravity Curve

Liq. Vol. % Temperature (F) Component Liq. Vol. Frac. Mid. Vol. % Gravity

6.5 120.0 Water 0.001 2.0 150.0

10.0 200.0 Methane 0.002 5.0 95.0

20.0 300.0 Ethane 0.005 10.0 65.0

30.0 400.0 Propane 0.005 20.0 45.0

40.0 470.0 Isobutane 0.01 30.0 40.0

50.0 550.0 N-Butane 0.01 40.0 38.0

60.0 650.0 2-Methyl-Butane 0.005 50.0 33.0

70.0 750.0 N-Pentane 0.025 60.0 30.0

80.0 850.0 70.0 25.0

90.0 1100.0 80.0 20.0

95.0 1300.0 90.0 15.0

98.0 1475.0 95.0 10.0

100.0 1670.0 98.0 5.0
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Starting Aspen Plus

To start Aspen Plus:

➤ From your Windows desktop, click Start, then select Programs.

➤ Select AspenTech, then Aspen Plus 10.1-0, then Aspen Plus User Interface.

  The Aspen Plus Startup dialog box appears.

Aspen Plus displays a dialog box whenever you must enter information or make a
selection before proceeding. In this simulation, you will use an Aspen Plus
template.

➤ Point the mouse to the Template radio button and click the left mouse button.

➤ Click OK.

  The New dialog box appears.

Use the New dialog box to specify the Application Type and Run Type for the new
run. Aspen Plus uses the Application Type you choose to set appropriate defaults
for your application. For this simulation, you will use the Petroleum with English
Units template and the Assay Data Analysis Run Type.

➤ Use the left mouse button to select the Petroleum with English Units template.

➤ Click the arrow to the right of the Run Type box to display the available run types.

➤ From the list, select Assay Data Analysis to specify an Assay Data Analysis/PCS run.

➤ Click OK.

Note If the Connect Host dialog box appears, see Appendix A.

Wait a few seconds while the changes are applied.

The Aspen Plus graphics workspace is shaded because you do not use a graphical
simulation flowsheet in specifying an Assay Data Analysis run.

Use the Aspen Plus expert guidance Next function to take you to the next
required input specification.
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➤ In the toolbar, click Next.

  The Setup Specifications Global sheet appears.

Specifying Title and Global Options

The Setup Specifications Global sheet displays the defaults Aspen Plus uses for
other forms. You will use this form to:

• Specify a title for your simulation
• Review the global settings that were set when you selected the Petroleum

with English Units Application Type

The Run Type Assay Data Analysis is already selected. You do not need to
change this field.

It is always good practice to describe your problem by entering a title for the
simulation.

➤ In the Title box, type Getting Started With Petroleum -- Session 1. Press Enter.

Since you chose the Petroleum with English Units Application Type when you
started this session, Aspen Plus has set the following global defaults for input
specifications:

• ENGPETRO units (English Engineering units appropriate for Petroleum
applications, such as volume flow in barrels per day)

• StdVol flow basis for all flow inputs
• Free-water calculations
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The form is complete, and all the defaults set by the Petroleum with English
Units Application Type are appropriate for this problem:

➤ On the Setup Specifications form, click the Next button at the right of the toolbar.

  The Components Specifications Selection sheet appears.
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Specifying Components

Use the Components Specifications Selection sheet to specify components for the
simulation.

➤ Enter the component IDs and component names shown below:

Component ID Component Name

H2O WATER

C1 METHANE

C2 ETHANE

C3 PROPANE

IC4 ISOBUTANE

NC4 N-BUTANE

IC5 2-METHYL-BUTANE

NC5 N-PENTANE

  

You will define two crude assays, OIL-1 and OIL-2.

➤ In the next Component ID field, type OIL-1.

➤ In the Type field for OIL-1, click the left mouse button and select Assay.

➤ Enter OIL-2 and identify it as an Assay, in the same way as you did for OIL-1.
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The Components Specifications form is complete:

➤ Click the Next button.

  The Components Assay/Blend Basic Data form for OIL-1 appears.
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Entering Assay Data
On the Components Assay/Blend Basic Data form for OIL-1, you will enter the
laboratory assay data for OIL-1 (Table 1.1).

➤ In the Distillation curve type field, click the list box. Select True boiling point (liquid
volume basis) to indicate you are entering data for a TBP curve on a standard liquid
volume basis.

➤ In the Bulk gravity value box, select the API gravity option by clicking the radio button.

➤ In the API gravity field, enter 31.4.

➤ In the Percent Distilled and Temperature fields, enter the following TBP distillation
values for OIL-1:

Percent Distilled Temperature F

6.8 130

10.0 180

30.0 418

50.0 650

62.0 800

70.0 903

76.0 1000

90.0 1255
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The Components Assay/Blend Basic Data Dist Curve sheet for OIL-1 is complete:

➤ Click the Light Ends tab.

  The Light Ends sheet for OIL-1 appears.

Use this sheet to enter light ends analysis data, given as a fraction of the assay
mixture.

➤ In the Component and StdVol Fraction fields, enter the following light ends analysis
data:

Component Fraction StdVol

C1 0.001

C2 0.0015

C3 0.009

IC4 0.004

NC4 0.016

IC5 0.012

NC5 0.017

The Light Ends sheet for OIL-1 is complete:
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➤ Click the Gravity/UOPK tab.

  The Gravity/UOPK sheet for OIL-1 appears.

➤ In the Type box, select API gravity by clicking the radio button.
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➤ In the Mid percent distilled and API gravity fields, enter the following API gravity curve
data:

Mid Percent Distilled API Gravity

5.0 90.0

10.0 68.0

15.0 59.7

20.0 52.0

30.0 42.0

40.0 35.0

45.0 32.0

50.0 28.5

60.0 23.0

70.0 18.0

80.0 13.5

  

The Gravity/UOPK sheet for OIL-1 is complete:

➤ Click the Next button.
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  The Assay/Blend Basic Data form for OIL-2 appears.

➤ Enter laboratory assay data for OIL-2 (Table 1.2) in the same way as you entered
assay data for OIL-1.

➤ In the Distillation Curve Type field, click the list box. Select True boiling point (liquid
volume basis) to indicate you are entering data for a TBP curve on a standard liquid
volume basis.

➤ In the Bulk gravity value box, select the API gravity option by clicking the radio button.

➤ In the API field, enter 34.8.

➤ In the Percent Distilled and Temperature fields, enter the following TBP distillation
values:

Percent Distilled Temperature F

6.5 120.0

10.0 200.0

20.0 300.0

30.0 400.0

40.0 470.0

50.0 550.0

60.0 650.0

70.0 750.0

80.0 850.0

90.0 1100.0

95.0 1300.0

98.0 1475.0

100.0 1670.0

  

The Assay/Blend Basic Data form for OIL-2 is complete.

➤ Click the Light Ends tab.

  The Light Ends sheet for OIL-2 appears.
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➤ In the Component and StdVol Fraction fields, enter the following light ends analysis
data:

Component Fraction StdVol

H2O 0.001

C1 0.002

C2 0.005

C3 0.005

IC4 0.01

NC4 0.01

IC5 0.005

NC5 0.025

The Light Ends sheet for OIL-2 is complete.

➤ Click the Gravity/UOPK tab.

  The Gravity/UOPK sheet for OIL-2 appears.

➤ In the Type box, select API gravity by clicking the radio button.

➤ In the Mid percent distilled and API gravity fields, enter the following API gravity curve
data:

Mid percent Distilled API gravity

2.0 150.0

5.0 95.0

10.0 65.0

20.0 45.0

30.0 40.0

40.0 38.0

50.0 33.0

60.0 30.0

70.0 25.0

80.0 20.0

90.0 15.0

95.0 10.0

98.0 5.0



Modeling Petroleum Processes 1-15
Version 10.1-0

Chapter 1

The Gravity/UOPK sheet for OIL-2 is complete.

➤ Click the Next button.

  The Required ADA/PCS Input Complete dialog box appears.
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Blending the Oils

You should be viewing the Required ADA/PCS Input Complete dialog box.

➤ To specify a blend, select Modify assay/blend specifications.

➤ Click OK.

  The Assay/Blend Object Manager appears.

➤ Select New.

  The Create New ID dialog box appears.

➤ Enter MIXOIL as the ID.

➤ Select BLEND as the Type.

➤ Click OK.

  The Mixture Specifications sheet for MIXOIL appears.

Use this sheet to define the fractions for each crude oil in the blend.

➤ Click the first Assay ID field and select OIL-1.

➤ In the StdVol Fraction field, enter 0.20.

➤ Click the next Assay ID field and select OIL-2.

➤ In the StdVol Fraction field, enter 0.80.
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The MIXOIL Mixture Specifications sheet is complete:

➤ Click the Next button.

  The Required ADA/PCS Input Complete dialog box appears.
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Generating Pseudocomponents

By default, Aspen Plus generates a set of pseudocomponents for your simulation
based on all the assays and blends in your problem. However, in this problem, the
pseudocomponents should be based on the blend only.

You should be viewing the Required ADA/PCS Input Complete dialog box.

➤ Select the Specify options for generating pseudocomponents.

➤ Click OK.

  The Petro Characterization Generation Object Manager appears.

➤ Select New.

➤ Enter CRUDE as the new ID, and click OK.

  The Specifications sheet for CRUDE appears.

➤ Click the Assay/Blend ID field and select MIXOIL.

The Specifications sheet is complete. You do not need to enter data in any other
fields.
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➤ Click the Next button.

  The Required ADA/PCS Input Complete dialog box appears.

➤ Select Go to Next required input step, and click OK.

  The Required Properties Input Complete dialog box appears.

➤ Click OK.

  The Required Assay Data Analysis/Pseudocomponent Generation Input Complete
dialog box appears.
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Running the Simulation
You have entered the data and specifications for this session. You can now run
the Assay Data Analysis.

➤ In the Required Assay Data Analysis/Pseudocomponent Generation Input Complete
dialog box, click OK.

Aspen Plus displays the Control Panel. The Control Panel allows you to monitor
and interact with the Aspen Plus simulation calculations.

As Aspen Plus performs the analysis, status messages will display in the Control
Panel. Soon you will see the message Results Available in the status bar at the
bottom of the main window.

➤ Use the vertical scroll bar to the right of the Control panel window to see the
messages.

You can now examine the results of your analysis.
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Examining Results
An ADA run calculates a wide variety of properties for the assays, blends, and
generated pseudocomponents.

For this session, you will review pseudocomponent properties and TBP curves for
the oils and the blend.

➤ Click the Check Results button  on the Control Panel.

  The Results Summary Run-Status form appears. It indicates that calculations were
completed normally. The main properties for each pseudocomponent appear on the
Components Petro Characterization Results Summary sheet.

➤ Expand the Components folder.

  The Assay/Blend and the Petro Characterization folders are revealed.

➤ Expand the Petro Characterization folder.

  The Results form is revealed.

➤ Click Results.

  The main properties for each pseudocomponent appear on the Components Petro
Characterization Results Summary sheet.

➤ Click the scroll arrow at the bottom left of the form to scroll through the component
properties.
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Plotting Distillation Curves

You will plot the TBP curves for the blend and each crude oil in a single plot. The
results for each assay or blend appear on the Components Assay/Blend Results
form. To plot the TBP curve for OIL-1:

➤ From the Data Browser, click the Assay/Blend folder to expand it.

  The MIXOIL, OIL-1, and OIL-2 folders are revealed.

➤ Click the OIL-1 folder to expand it.

  The Results form is revealed.

➤ Click the Curves tab.
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  The Curves sheet for OIL-1 appears.

To plot the TBP curve:

➤ Select the Percent distilled column by clicking on the column heading.

➤ From the Plot menu on the Aspen Plus toolbar, select X-Axis Variable.

➤ Select the True boiling pt. (liquid volume) column by clicking on the column heading.

➤ From the Plot menu, select Y-Axis Variable.

➤ From the Plot menu, select Display Plot.

  The TBP curve for OIL-1 appears in a new window.

To label this curve for OIL-1:

➤ Double-click the legend box.

  The Plot Legend Box dialog box appears.
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➤ Select True boiling pt (vol).

➤ Edit the Text field to read TBP for OIL-1.

➤ Click Replace.

➤ Click OK.

To plot the TBP curve for OIL-2, select the data and assign it to the X and Y-axes
the same way you did for OIL-1.

➤ Expand the OIL-2 folder in the Data Browser.

  The Results form is revealed.

➤ Click the Curves tab.

  The Curves sheet for OIL-2 appears.

➤ Select the Percent distilled column.

➤ From the Plot menu on the Aspen Plus toolbar, select X-Axis Variable.

➤ Select the True boiling pt. (liquid volume) column.

➤ From the Plot menu, select Y-Axis Variable.

To add this curve to the plot containing the curve for OIL-1: .

➤ From the Plot pulldown menu, select Add New Curve.

  The Plot Window List dialog box appears. 

➤ Select the available item, and click OK.

The curve for OIL-2 appears on the plot. To label this curve for OIL-2:

➤ Double-click the legend box.

  The Plot Legend Box dialog box appears.

➤ Select True boiling pt (vol).
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➤ Edit the Text field to read TBP for OIL-2.

➤ Click Replace.

➤ Click OK.

To plot the BLEND curve:

➤ In the Data Browser, click the MIXOIL folder to expand it.

  The Results form is revealed.

➤ Click the Curves tab.

  The Curves sheet for MIXOIL appears.

Add this curve to the plot containing curves for OIL-1 and OIL-2, using the same
procedure as for OIL-2.

➤ Select the Percent distilled column.

➤ From the Plot menu on the Aspen Plus toolbar, select X-Axis Variable.
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➤ Select the True boiling pt. (liquid volume) column.

➤ From the Plot menu, select Y-Axis Variable.

To add this curve to the plot containing the curve for OIL-1 and OIL-2: .

➤ From the Plot pulldown menu, select Add New Curve.

  The Plot Window List dialog box appears. 

➤ Select the available item, and click OK.

The curve for MIXOIL appears on the plot. To label this curve for MIXOIL:

➤ Double-click the legend box.

  The Plot Legend Box dialog box appears.

➤ Select True boiling pt (vol).

➤ Edit the Text field to read TBP for Blend.

➤ Click Replace.

➤ Click OK.

To combine the y-axes:

➤ Double-click on the plot.

➤ Select the AxisMap tab.

➤ Select All in One, and click OK.

➤ Edit the plot title to read TBP Curves for Crude Oils and Blend.

➤ Double-click the plot title to select it.

➤ Type TBP Curves for Crude Oils and Blend.
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➤ Click OK.

As the completed plot shows, the TBP curve for the blend is between the curves
for each oil. Curve locations depend on the proportions of the two oils you define
for the blend:
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Creating a Backup File

Once you are satisfied with your Assay Data Analysis results, you can save this
simulation as a backup file. This allows you to use the assay data analysis you
have developed in another Aspen Plus simulation.

To save this simulation as a backup file:

➤ From the File menu, select Save As.

➤ In the Save As dialog box, select Aspen Plus Backup Files for the Save as type.

➤ In the File name field, enter BLEND.

  Your working directory appears in the Save In box.

Your simulation is saved as blend.bkp.
  A dialog box asks if you also want to save the simulation as an Aspen Plus Document

file.

➤ Click No.
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Exiting Aspen Plus

To exit Aspen Plus:

➤ From the Aspen Plus File menu, select Exit.

This run will be used as the starting point for the session in Chapter 2.

❖ ❖    ❖    ❖
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2 Adding a Preflash Tower

In this session you will add a preflash tower to the simulation. You will also
specify options for pseudocomponent generation.

You will:

• Define the flowsheet graphically
• Specify properties, feed streams, and preflash tower
• Modify cuts specifications for pseudocomponents generation
• Run the simulation
• Examine simulation results

Allow about 45 minutes to complete this session.
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Preflash Tower Flowsheet

Figure 2.1 shows the process flowsheet for this session. The process feed, consisting
of the oil blend, goes first to the preflash furnace where it is partially vaporized.
The partially vaporized feed then enters the preflash tower. You will model the
tower and the furnace simultaneously with a single PetroFrac block.

Steam is fed to the bottom of the tower. The tower produces a wide naphtha cut
as a distillate product.

Figure 2.1 Flowsheet for Preflash Tower

You will simulate the tower with 10 theoretical stages, no reboiler, and a partial
condenser. The condenser operates at 170 F and 39.7 psia, with a pressure drop
of 2 psi. The tower pressure drop is 3 psi.

The tower is stripped with open steam in the bottom. The steam stream is at 400
F and 60 psia, and has a flow rate of 5,000 lb/hr. The furnace operates at a
pressure of 50 psia and a temperature of 450 F. The distillate rate is estimated at
15,000 bbl/day. Its value is manipulated to produce a wide naphtha cut with an
ASTM 95% temperature of 375 F.
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Starting Aspen Plus

To start Aspen Plus:

➤ Use the Windows Start menu, or double-click the Aspen Plus icon on your
desktop.

Note If the Connect Host dialog box appears, see Appendix A.

  The Aspen Plus Startup dialog box appears.



2-4 Modeling Petroleum Processes
Version 10.1-0

Adding a
Preflash
Tower

Opening an Existing Run
If you saved the assay data analysis simulation created in Chapter 1:

➤ In the Aspen Plus Startup dialog box, select Open an Existing Simulation .

If your saved file blend.bkp appears in the list box:

➤ Select blend.bkp in the list and click OK.

If your saved file blend.bkp does not appear in the list box:

➤ Double-click on More Files… in the list box.

  The Open dialog box appears.

➤ Navigate to the directory containing your saved file blend.bkp.

➤ Select blend.bkp from the list of files, and click Open.

Note If the Connect to Engine dialog box appears, see Appendix A.

  The Aspen Plus main window appears.

If you did not create the assay data analysis simulation in Chapter 1, you can
open the backup file blend.bkp in the Examples folder.

➤ From the Aspen Plus Startup dialog box, select Open an Existing Simulation, then
click OK.

  The Open dialog box appears.

➤ Click the Look in Favorites button .

By default, the Favorites list contains five folders that are provided with
Aspen Plus.

➤ Double-click the Examples folder.

➤ Select blend.bkp, and click Open.

Note If the Connect to Engine dialog box appears, see Appendix A.

  The Aspen Plus main window appears.



Modeling Petroleum Processes 2-5
Version 10.1-0

Chapter 2

Saving a Run Under a New Name

Before you create a new run adding a preflash tower, you will create and save a
copy of BLEND with a new Run ID, PREFLASH. Then you can make modifications
under this new Run ID.

➤ From the File menu, click Save As.

  The Save As dialog box appears.

➤ Choose the directory where you want to save the simulation.

➤ In the File name box, enter the new filename PREFLASH.

➤ From the Save as Type list, select Aspen Plus Backup Files (*.bkp).

➤ Click Save to save the simulation and continue.

  A dialog box asks if you also want to save the simulation as an Aspen Plus Document
file.

➤ Click No.

  The current Run ID, PREFLASH, appears in the titlebar.
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Changing the Run Type

In Chapter 1, the BLEND run you performed was an Assay Data Analysis run. In
this session, you will perform a flowsheet simulation. You need to switch to the
Flowsheet Run Type.

➤ From the Data menu, select Setup.

  The Setup Specifications form appears.

➤ Click the Run type field. Select Flowsheet from the list.

➤ Change the simulation title to Getting Started with Petroleum-Session 2.

➤ Close the window.

The graphics workspace is now active and ready for you to build the flowsheet.
No more changes to this form are necessary.
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Selecting a Distillation Model

Aspen Plus offers several distillation models. To determine which is appropriate for
the preflash tower, you will use prompts and online help.

➤ From the Aspen Plus main window, click the Columns tab on the Model Library.

  The list of available distillation columns is displayed.

➤ Move the mouse over any model in the Model Library and read the description in the
lower left of the window.

From the prompts, it appears that PetroFrac is appropriate for this petroleum
problem. You can obtain more extensive information on PetroFrac by reading the
online help:

➤ Click PetroFrac.

➤ Press the Help Key–F1 on most systems.

  A Help window appears, with detailed information about PetroFrac.

➤ Review this information to confirm that PetroFrac is the best choice, then close the
Help window.
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Defining the Graphical Simulation
Flowsheet

Now you will begin to build the process flowsheet. Since you will enter your own
block and stream IDs, you must turn off the default Create auto block ID and
Create auto stream ID options, which provide these IDs automatically.

➤ From the Tools menu, select Options.

  The Options dialog box appears.

➤ Click the Flowsheet tab.

➤ Click the Automatically assign block name check box, to deselect this option.

➤ Click the Automatically assign stream name check box, to deselect this option.

➤ Click OK to apply these changes.
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You are ready to build your flowsheet. Figure 2-1 shows the process flow diagram
for this session. To review how to define a flowsheet graphically, see Getting
Started Building and Running a Process Model, Chapter 2.

To place and connect the distillation unit on the flowsheet:

➤ Click the Column tab in the Model Library.

➤ In the Model Library, select PetroFrac, the unit operation model that you want to place
in your process flowsheet.

You can choose a different icon for the model:

➤ Click the down arrow next to the PetroFrac block icon to display all the icons available
for the PetroFrac model.

➤ Move the mouse over the icons to see a name (or label) for each.

In this exercise, you will select the PetroFrac icon PREFL1F.

➤ Hold down the mouse button on the PetroFrac icon PREFL1F, and drag the icon to the
Process Flowsheet window. Release the mouse button when the icon is in the desired
location.

  The Input dialog box appears.

➤ Enter the Block ID PREFLASH, and click OK.

Connect and name the streams, as shown in Figure 2.1. You can use the port
names shown below to connect to the appropriate port.

Stream Port

MIXCRUDE Main Column Feed

PF-STEAM Main Column Feed

LIGHTS Vapor Distillate from Main Column

PF-WATER Condensed Water Decant for Main Column

NAPHTHA Liquid Distillate from Main Column

CDU-FEED Bottoms Product from Main Column

➤ Click the Material Stream icon on the left side of the Model Library.



2-10 Modeling Petroleum Processes
Version 10.1-0

Adding a
Preflash
Tower

➤ Move the cursor to the Process Flowsheet window. Point to the Main Column Feed
port on the PetroFrac and click to create a new stream.

➤ Point to a blank part of the process flowsheet window where you want the feed to
originate and click once.

➤ Enter the Stream ID PF-STEAM, and click OK.

➤ Create the remaining streams in similar fashion.

  For the MIXCRUDE stream, first connect it to the bottom feed port and then drag it to
the desired location in front of the feed furnace.

➤ In the Aspen Plus main window toolbar, click the Next button to guide you to the next
required input.

  The Flowsheet Complete dialog box appears.

➤ Click OK.

  The Properties Specifications Global sheet appears.
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Specifying Properties

Use the Properties Specifications Global sheet to select the thermodynamic
methods used to calculate properties such as K-values, enthalpy, and density.
Property methods in Aspen Plus are arranged according to Process Types, and in
logical groupings called Base Methods. The BK10 physical property option set
(Braun K-10 method) is appropriate for most refining applications involving heavy
petroleum fractions and low pressures.

➤ To select the BK10 option set for the physical properties, click the arrow to the right of
the Process Type box, and select REFINERY.

➤ Click the arrow to the right of the Base Method box, and select BK10.

Since you selected the Petroleum with English Units Application Type in Chapter
1, Aspen Plus has selected appropriate defaults for petroleum applications.
Steam Tables (STEAM-TA) is the default for the free-water phase properties, as
shown in the Free-water method field. Aspen Plus has also selected Method 2 for
the water solubility default, as shown in the Water solubility field. The Water
solubility option controls the method for calculating the solubility and K-value of
water in the hydrocarbon phase.

You do not need to change anything on this form.
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➤ Click the Next button.

  The Required Properties Input Complete dialog box appears.

Correct representation of physical properties is essential to process modeling. For
many simulations, the only physical property specification you must provide is to
select an option set. The Required Properties Input Complete dialog box is a
reminder that the Aspen Plus physical property system has many optional
capabilities that you can use to increase the accuracy of physical property
calculations.

➤ Click OK.

  The Stream MIXCRUDE Input form appears.



Modeling Petroleum Processes 2-13
Version 10.1-0

Chapter 2

Entering Stream Data

You should be viewing the Stream MIXCRUDE Input form, as indicated in the
Data Browser window title bar. MIXCRUDE is the crude oil blend feed stream to
the tower. You will enter condition and flow rates for the MIXCRUDE stream.

➤ In the Temperature field, enter the feed temperature 200. The default units F
(Fahrenheit) are correct for this session.

➤ In the Pressure field, enter 60. The default units PSI are correct for this session.

➤ Enter 100000 for the MIXOIL component flow value. This is the oil flow rate in bbl/day.

The Streams Input form for MIXCRUDE is complete:

➤ Click the Next button.
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  The Input form for PF-STEAM appears. PF-STEAM is the steam feed to the tower.

➤ In the Temperature field, enter 400 F.

➤ In the Pressure field, enter 60 PSI.

➤ In the Composition area, click the arrow and select Mass-Flow to specify the steam
flow in lb/hr.

➤ Enter 5000 for the H2O component value, to enter a Steam flow rate of 5000 lb/hr.

The Input form for PF-STEAM is complete:

➤ Click the Next button.

  The PREFLASH Setup Configuration sheet appears.
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Specifying the Preflash Unit

Use the PREFLASH Setup Configuration sheet to enter configuration and
operating specifications for the column, including:

• Number of theoretical stages
• Valid phases in the column
• Distillate vapor fraction

➤ In the Number of stages field, enter 10 for ten theoretical stages.

➤ Click the Condenser list box and select Partial-Vapor-Liquid. This indicates that there
is a partial condenser with both vapor and liquid distillate.

In the Reboiler field, the default None-Bottom-Feed is appropriate, since the
column has no reboiler and there is a bottom steam feed.

➤ In the Distillate rate field, enter 15000 to specify an estimate for the distillate rate of
15,000 bbl/day.

The distillate rate will be manipulated to achieve a specification on the ASTM
95% temperature for the naphtha product.

The Blocks PREFLASH Setup Configuration sheet is complete.
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➤ Click the Next button.

  The Blocks PREFLASH Setup Streams sheet appears.

You will enter feed locations and conventions for the MIXCRUDE stream.

➤ For MIXCRUDE, enter 10 in the Stage field. Click the convention list box, and select
Furnace to indicate that a furnace is attached to the tower on stage 10. The feed goes
to the furnace first.

➤ For PF-STEAM, enter 10 in the Stage field. Click the convention list box and select
On-Stage.

The Blocks PREFLASH Setup Streams sheet is complete:

➤ Click the Next button.

  The Setup Pressure sheet for the PREFLASH block appears. On this sheet, you will
enter the column pressure profile, or specify a top stage pressure and a pressure drop
or the rest of the column.

➤ Click the arrow to the right of the View box to display a list of available views. Select
Top/Bottom.
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➤ Enter the following pressure profile data:

Top Stage Pressure 39.7 PSI

Second Stage Pressure 41.7 PSI

Bottom Stage Pressure 44.7 PSI

The Setup Pressure sheet is complete.

➤ Click the Next button.

  The Setup Condenser sheet appears.

➤ Click the Temperature radio button. Enter a value of 170 F.

The Setup Condenser sheet is complete.

➤ Click the Next button.

  The Setup Furnace sheet appears.

➤ Select Single stage flash as the furnace type.

➤ Enter the following information to specify furnace operating conditions:

Furnace temperature 450 F
Furnace pressure 50 PSI

These specifications model the furnace as a single-stage flash at the specified
conditions.
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The Setup Furnace form for the PREFLASH block is complete:

➤ Click the Next button.

  The Required Input Complete dialog box appears.

➤ Click Cancel.

Next, you need to set up a design specification for the product quality of the
naphtha stream, using the ASTM 95% temperature. You will manipulate the
distillate rate to achieve this target.

➤ From the Data Browser, select the PREFLASH block’s Design Specs folder.

  The Design Specs Object Manager appears.

➤ Select New.

➤ In the dialog box, click OK to accept the default ID, 1.

  The Design Spec 1 form appears.
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➤ On the Specifications sheet, enter the following information for the naphtha product
design specification:

Type ASTM D86 temperature (dry, liquid volume basis)
Target 375 F
Liquid % 95

➤ Click Next.

➤ On the Feed/Product Streams sheet, move the NAPHTHA stream from the Available
streams area to the Selected streams area using the single arrow key.

➤ Click Next.

➤ On the Vary sheet, select Distillate flow rate from the available list.

➤ Click the Next button.

  The Required Input Complete dialog box appears.

➤ Click Cancel.
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Modifying Pseudocomponents

In Chapter 1, Aspen Plus generated all pseudocomponents using default options. In
this session, you will modify the number of pseudocomponents generated for
different temperature ranges.

➤ From the Data Browser, click the Components folder to expand it.

➤ Expand the Petroleum Characterization folder. Click Generation.

  The Object Manager appears.

➤ Click CRUDE, then click the Edit button.

  The Specifications sheet appears.

➤ Click the Cuts tab.

➤ Click the Range and Increments radio button.

➤ Enter the following temperature ranges and increments to generate
pseudocomponents for this problem:

Lower temperature 100 Upper temperature 800 Increment 25

Upper temperature 1200 Increment 50

Upper temperature 1400 Increment 100

Upper temperature 1640 Increment 120
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The Cuts sheet is complete:

➤ Click the Next button.

  The Required ADA-PCS Input Complete dialog box appears.

➤ Click OK.

  The Required Input Complete dialog box appears.
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Running the Simulation

To run the simulation:

➤ Click OK in the Required Input Complete dialog box.

  The Control Panel appears.

As the run proceeds, status messages appear in the Control Panel. It takes about
a minute for Aspen Plus to process input specifications and perform the
simulation. When the calculations finish, the message Results Available appears
in the status bar at the bottom of the main window.

➤ Use the vertical scroll bar to the right of the Control panel window to see the
messages.

➤ When the Results Available message appears in the toolbar, click the Close button to
close the Control Panel window.

➤ Click the Close button to close the Data Browser.

You can now examine the results of your run.
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Examining Simulation Results

Aspen Plus produces a wide variety of simulation results. In this session you will
examine:

• Condenser duty
• Distillate rate
• Temperature profile
• Crude TBP curves

Condenser duty results appear on the PREFLASH Results Summary sheet. To
examine these results:

➤ Select the PREFLASH block by clicking the PREFLASH icon.

➤ Press or click the right mouse button to display the Block menu.

➤ Select Results.

  The Results Summary form for PREFLASH appears, showing a summary of all
condenser and bottom stage results.
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Distillate rate results appear on the PREFLASH Design Specs 1 Results sheet.
To examine distillate rate results:

➤ Expand the Design Specs folder in the Data Browser, and click design-spec 1.

  The Design Specs 1 form is revealed.

➤ Click the Results tab.

  The Results sheet appears, showing the distillate rate value that Aspen Plus
calculated to satisfy the design specification.

The temperature profile for the column appears on the PREFLASH Profile form.
To examine results by plotting a temperature profile:

➤ In the Data Browser, click the Profiles form.

  The PREFLASH Profiles form appears.
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To plot the temperature profile:

➤ From the Plot menu, select Plot Wizard.

  The Plot Wizard Step 1 dialog box appears.

➤ Click the Next> button.

➤ Click the Temperature Plot Type.

  The Plot Wizard Step 2 dialog box appears.

➤ Click the Next> button.

  The Plot Wizard Step 3 dialog box appears.

➤ Click the Next> button.

  The Plot Wizard Step 4 dialog box appears.

➤ Click the Finish button.
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  The temperature profile plot appears.

You can follow the same steps to display any other column profile. You may want
to close some forms to make space for the new plots.

The True Boiling Point curves appear on the Stream Results Vol.% Curves sheet.
To plot TBP curves for PREFLASH feed and product streams:

➤ In the Data Browser, click the PREFLASH Stream Results form.

  The Stream Results form is revealed.

➤ Click the Vol.% Curves tab.
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  The Stream Results Vol.% Curves sheet is displayed.

To select CDU-FEED and MIXCRUDE as dependent variables:

➤ Click the CDU-FEED column label to select the column.

➤ Move the mouse to the MIXCRUDE column. Ctrl-Click the MIXCRUDE column label to
select the MIXCRUDE column in addition to the CDU-FEED column.

➤ From the Aspen Plus Plot menu, select Y-Axis Variable.

➤ Click the Volume % column label.

➤ From the Aspen Plus Plot menu, select X-Axis Variable.

➤ From the Aspen Plus Plot menu, select Display Plot.
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  Aspen Plus displays the following plot:

As expected, the preflash tower removes a significant portion of the light
material from the process feed. This reduces the load for the subsequent
atmospheric crude unit and increases overall process capacity.

➤ When you finish viewing this plot, close the Plot window. 
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Exiting Aspen Plus

To exit Aspen Plus:

➤ From the File menu, select Exit.

  A dialog box asks if you want to save your simulation.

➤ Select Yes to save the simulation.

  A dialog box asks if you also want save the simulation as an Aspen Plus Document
file.

➤ Click No.

This run will be used as the starting point for the session in Chapter 3.

❖ ❖    ❖    ❖
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3 Adding an Atmospheric
Crude Distillation Unit

In this session, you will add an atmospheric crude distillation unit to the
simulation you ran in Chapter 2.

You will:

• Add the atmospheric crude distillation unit to the flowsheet.
• Specify additional feed streams.
• Specify the atmospheric crude distillation unit.
• Run the simulation.
• Examine the results.

Allow about 45 minutes to complete this session.
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Atmospheric Crude Distillation Unit
Flowsheet

Figure 3.1 shows the process flowsheet you will develop in this session. The
topped crude from the preflash tower goes first to the crude furnace, then to the
atmospheric tower. You will model the crude furnace and the atmospheric tower
units together, using a single PetroFrac block. This approach enables you to
adjust furnace variables to achieve certain tower specifications, such as the
overflash. The tower has:

• A total condenser
• Three coupled side strippers
• Two pumparound circuits

Figure 3.1 Process Flowsheet: The Atmospheric Crude Distillation Unit

PetroFrac simulates the furnace and the atmospheric tower simultaneously, as a
single unit. The furnace operates at a pressure of 24.18 psia and provides an
overflash of 3% in the tower. The furnace outlet enters the atmospheric tower on
stage 22 of the main fractionator.

The main fractionator is modeled with 25 equilibrium stages. The heavy naphtha
product flow is estimated at 13,000 bbl/day, and is manipulated to achieve an
ASTM 95% temperature of 375 F. The condenser operates at 15.7 psia with a
pressure drop of 5 psi. The tower pressure drop is 4 psi.
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The main fractionator has 2 pumparound circuits. The following table
summarizes the pumparound locations and specifications:

Pumparound Location Specifications

1 From stage 8 to 6 Flow: 49,000 bbl/day Duty:  -40 MMBTU/hr

2 From stage 14 to 13 Flow: 11,000 bbl/day Duty:  -15 MMBTU/hr

The crude distillation unit has three sidestrippers. Their locations and operating
specifications are:

Stripper Location Specifications

KEROSENE Liquid draw from stage 6
Vapor return to 5

Product rate: 11,700 bbl/day
Steam stripping (CU-STM1)
4 equilibrium stages

DIESEL Liquid draw from stage 13
Vapor return to 12

Product rate: 16,500 bbl/day (estimate)
Steam stripping (CU-STM2)
3 equilibrium stages

AGO Liquid draw from stage 18
Vapor return to 17

Product rate:  8,500 bbl/day
Steam stripping (CU-STM3)  2 equilibrium stages

The diesel flow rate is an estimate only. You will manipulate it to achieve an
ASTM 95% temperature of 640 F for the diesel product.

All sidestrippers and the main fractionator use steam for stripping. The following
table summarizes the steam flows and conditions:

 Stream Location Conditions and Flow

CU-STEAM Main tower 400 F, 60 psia, 12,000 lb/hr

CU-STM1 Kerosene stripper 400 F, 60 psia, 3,300 lb/hr

CU-STM2 Diesel stripper 400 F, 60 psia, 1,000 lb/hr

CU-STM3 AGO stripper 400 F, 60 psia, 800 lb/hr
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Starting Aspen Plus

To start Aspen Plus:

➤ Use the Windows Start menu or double-click the Aspen Plus icon on your desktop.

Note If the Connect Host dialog box appears, see Appendix A.

  The Aspen Plus Startup dialog box appears.
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Opening an Existing Run
If you saved the preflash flowsheet simulation created in Chapter 2:

➤ In the Aspen Plus Startup dialog box, select Open an Existing Simulation.

If your saved file preflash.bkp appears in the list box:

➤ Select preflash.bkp from the list and click OK.

If your saved file preflash.bkp does not appear in the list box:

➤ Double-click More Files… in the list box.

  The Open dialog box appears.

➤ Navigate to the directory containing your saved file preflash.bkp.

➤ Select preflash.bkp from the list of files and click Open.

Note If the Connect to Engine dialog box appears, see Appendix A.

  The Aspen Plus main window appears.

If you did not create the assay data analysis simulation in Chapter 2, you can
open the backup file preflash.bkp in the Examples folder.

➤ From the Aspen Plus Startup dialog box, select Open an Existing Simulation. Click
OK.

  The Open dialog box appears.

➤ Click the Look in Favorites button .

  By default, the Favorites list contains five folders that are provided with Aspen Plus.

➤ Double-click the Examples folder.

➤ Select preflash.bkp and click Open.

Note If the Connect to Engine dialog box appears, see Appendix A.

  The Aspen Plus main window appears.
  Aspen Plus displays the graphical flowsheet for the PREFLASH run.
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Saving a Run Under a New Name
Before you create a new run adding the atmospheric crude unit, you will create
and save a copy of PREFLASH with a new Run ID, CRUDE. Then you can make
modifications under this new Run ID.

➤ From the File menu, click Save As.

  The Save As dialog box appears.

➤ Choose the directory where you want to save the simulation.

➤ In the Filename box, enter the new filename CRUDE.

➤ From the Save as Type list, select Aspen Plus Backup Files (*.bkp).

➤ Click Save to save the simulation and continue.

  A dialog box asks if you also want to save the simulation as an Aspen Plus Document
file.

➤ Click No.

The current run ID, CRUDE, now appears in the titlebar. To update the title for
this run:

➤ From the Data menu, select Setup.

  The Setup Specifications form appears.

➤ Change the simulation title to Getting Started with Petroleum-Session 3.

➤ Close the window.

The graphics workspace is now active and ready for you to add to the existing
flowsheet.



Modeling Petroleum Processes 3-7
Version 10.1-0

Chapter 3

Adding the Crude Distillation Unit to the
Flowsheet

You are ready to add the crude distillation unit to the flowsheet. To make space
for the new tower:

➤ Drag a region around the entire flowsheet.

➤ Press and hold the left mouse button within the region and drag the flowsheet to the
left, to make room for the crude distillation unit, as shown in Figure 3.1.

To place and connect the distillation unit on the flowsheet:

➤ In the Model Library, click the Column tab.

➤ Select the unit operation model, PetroFrac, to place in your process flowsheet.

➤ Click the down arrow next to the PetroFrac block icon to display all the icons available
for the PetroFrac model.

➤ Move the mouse over the icons to see a name (or label) for each.

In this exercise, you will select the PetroFrac icon CDU10F.

➤ Hold down the mouse button on the PetroFrac icon CDU10F, and drag the icon to the
Process Flowsheet window. Release the mouse button in the desired location.

➤ Place the CDU10F icon in the flowsheet, as shown in Figure 3.1. Name the block
CRUDE.

➤ To increase the size of the icon, click the PetroFrac icon, hold down the Shift key, then
press the + key.

To reconnect the distillation unit to the preflash block already on the flowsheet:

➤ Select the CDU-FEED stream.

➤ Click the right mouse button on the stream, and select Reconnect Destination from the
menu that appears.
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➤ Point to the Main Column Feed port at the bottom of the column.

➤ Click to connect the CDU-FEED stream to the bottom feed port and then drag it to the
desired location in front of the feed furnace

➤ To display the flowsheet as large as possible, from the View menu, select Zoom full.

➤ Connect, move, and name the streams as shown in Figure 3.1. Use the port names in
Table 3.1 to help you connect to the appropriate port.

Table 3.1 Streams and Corresponding Ports

Stream ID Port Name

CDU-FEED Main Column Feed

CU-STEAM Main Column Feed

CU-STM1 Stripper Steam Feeds

CU-STM2 Stripper Steam Feeds

CU-STM3 Stripper Steam Feeds

CU-WATER Condenser Water Decant for Main Column

HNAPHTHA Liquid Distillate from Main Column

KEROSENE Bottoms Product from Stripper

DIESEL Bottoms Product from Stripper

AGO Bottoms Product from Stripper

RED-CRD Bottoms Product from Main Column

You have finished adding the distillation unit to the flowsheet.

➤ Click the Next button.

  The Flowsheet Complete dialog box appears.

➤ Click OK.

  The Input form for stream CU-STEAM appears.
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Specifying Steam Feeds to the Tower
Use the Input form for stream CU-STEAM to enter the specifications for the
steam feed to the main column.

➤ Enter the following state variable and component flow specifications:

Temperature   400 F
Pressure   60 PSI
Composition Basis   Mass-Flow LB/HR
H2O Flow value   12000 LB/HR

The Input form for CU-STEAM is complete:

➤ Click the Next button.

  The Input form for CU-STM1 appears.

➤ Enter the following state variable and component flow specifications:

Temperature 400 F
Pressure 60 PSI
Composition Basis Mass-Flow LB/HR
H2O Flow value 3300 LB/HR

➤ Click the Next button.
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  The Input form for CU-STM2 appears.

➤ Enter the following state variable and component flow specifications:

Temperature 400 F
Pressure 60 PSI
Composition Basis Mass-Flow LB/HR
H2O Flow value 1000 LB/HR

➤  Click the Next button.

  The Input form for CU-STM3 appears.

➤ Enter the following state variable and component flow specifications:

Temperature 400 F
Pressure 60 PSI
Composition Basis Mass-Flow LB/HR
H2O Flow value 800 LB/HR

You have finished entering steam feed specifications.

➤ Click the Next button.

  The Blocks CRUDE Setup form appears.
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Specifying the Atmospheric Tower
Use the Blocks CRUDE Setup form to specify the main column configuration.

➤ On the Configuration sheet, specify:

Number of stages 25
Condenser Total
Reboiler None-Bottom Feed
Distillate rate 13000 BBL/DAY

The distillate flow rate is an estimate. This value will be manipulated to achieve
the desired ASTM 95% temperature for the heavy naphtha stream.

➤ Click the Next button.

  The Blocks CRUDE Setup Streams sheet appears.

➤ Enter the following feed locations and conventions:

Stage Convention

CDU-FEED 22 Furnace

CU-STEAM 25 On-Stage
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The Furnace feed convention attaches a furnace to stage 22. This furnace is
solved simultaneously with the main fractionation column and strippers.

➤ Click the Next button.

  The Pressure sheet appears.

➤ Enter the following pressures using the Top/Bottom View:

Stage 1 / Condenser Pressure 15.7 PSI
Stage 2 Pressure 20.7 PSI
Bottom Stage Pressure 24.7 PSI

➤ Click the Next button.

  The Furnace sheet appears.

➤ Select the Single stage flash Furnace type

➤ Specify a StdVol Fractional overflash of 0.03 and a Furnace pressure of 24.18 psi.
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The Furnace sheet is now complete:

You have completed specifications for the main column.

➤ Click the Next button.
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Because you attached feed and product streams for three sidestrippers in the
graphical flowsheet, Aspen Plus automatically configured this block with three
sidestrippers: S-1, S-2, and S-3.

  The Setup form for Stripper S-1 appears.

➤ Enter the following specifications:

Number of stages 4
Liquid draw stage 6
Overhead return stage 5
Stripper product KEROSENE
Stripping steam CU-STM1
Bottom product flow 11700 BBL/DAY

The S-1 Setup form is complete:

➤ Click the Next button.

  The S-2 Setup form appears.

➤ Enter the following specifications:

Number of stages 3
Liquid draw stage 13
Overhead return stage 12
Stripper product DIESEL
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Stripping steam CU-STM2
Bottom product flow 16500 BBL/DAY

The S-2 Setup form is complete:

➤ Click the Next button.

  The S-3 Setup form appears.

➤ Enter the following specifications:

Number of stages 2
Liquid draw stage 18
Overhead return stage 17
Stripper product AGO
Stripping steam CU-STM3
Bottom product flow 8500 BBL/DAY
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The S-3 Setup form is complete:

➤ Click the Next button.

  The Required Input Complete dialog box appears.

➤ Click Cancel.

Next, you will supply specifications for Pumparound 1 and Pumparound 2.

➤ In the Data Browser, click the Block CRUDE Pumparounds folder.

  The Pumparounds Object Manager sheet appears.

➤ Select New.

➤ In the dialog box, click OK to accept the default ID P-1.

  The Pumparounds P-1 Specifications sheet appears.



Modeling Petroleum Processes 3-17
Version 10.1-0

Chapter 3

➤ To specify P-1, enter:

Draw stage 8
Return stage 6
Drawoff type Partial
StdVol Flow 49000 BBL/DAY

Heat duty -40.0 MMBTU/HR

The Pumparounds P-1 Specifications sheet is complete:

➤ Click the Pumparounds folder to reopen the Object Manager.

  The Pumparound Object Manager appears.

➤ Select New.

➤ In the dialog box, click OK to accept the default ID P-2.

  The Pumparounds P-2 Specifications sheet appears.

➤ Enter the following specifications for P-2:

Draw stage 14
Return stage 13
Drawoff type PARTIAL
StdVol Flow 11000 BBL/DAY

Heat duty -15.0 MMBTU/HR
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The Pumparounds P-2 Specifications sheet is complete:

➤ Click the Next button.

  The Required Input Complete dialog box appears.

➤ Click Cancel.

You have completed all required PetroFrac specifications. However, in this
session you will specify two design specifications, the ASTM 95% temperature for
HNAPHTHA and for DIESEL.

➤ From the Data Browser, click the Blocks CRUDE Design Specs folder.

  The Design Spec Object Manager appears.

➤ Click New.

➤ In the dialog box, click OK to accept the default ID 1.

  The Blocks CRUDE Design Specs 1 Specifications sheet appears.

First, you will enter specifications to have PetroFrac manipulate the distillate
rate to achieve an ASTM 95% temperature of 375 F for HNAPHTHA:

➤ In the Type field, select ASTM D86 temperature (dry. liquid volume basis) .
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➤ Enter the following specifications:

Target 375
Liquid % 95

➤ Click the Next button.

  The Feed/Product Streams sheet appears.

➤ Move HNAPTHA from the Available streams area to the Selected stream area by
clicking the > button.
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➤ Click the Next button.

  The Vary sheet appears.

➤ Click the arrow to the right of the Type box, and select Distillate flow rate from the list.
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The HNAPHTHA design specification is complete.

➤ Click the Design Specs folder to reopen the Object manager.

For the second design specification, you will enter specifications to have
PetroFrac manipulate the DIESEL flow rate to reach an ASTM 95% temperature
of 640 F.

  The Design Specs Object Manager appears.

➤ Click New.

➤ In the dialog box, click OK to accept the default ID 2.

  The Block CRUDE Design Specs 2 Specifications sheet appears.

➤ Enter, or use List to select, the following specifications:

SpecType ASTM D86 temperature (dry. liquid volume basis)
Target 640
Liquid % 95

➤ Click the Next button.

  The Feed/Product Streams sheet appears.
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➤ Move the DIESEL stream from the Available streams area to the Selected stream area
using the > button.

➤ Click the Next button.

  The Vary sheet appears.

➤ Select Bottoms flow rate as the Adjusted variable Type.

➤ Select S-2 as the Stripper name.



Modeling Petroleum Processes 3-23
Version 10.1-0

Chapter 3

The Block CRUDE Design Specs 2 form is complete:

You have entered all the specifications for the atmospheric crude tower, without
any initial profile estimates for tower temperatures, flow rates, or compositions.
Aspen Plus can converge the column without estimates for these variables.

➤ Close the Data Browser window.

➤ In the Aspen Plus main window, click the Next button.
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Running the Simulation

To run the simulation:

➤ In the Required Input Complete dialog box, click OK.

  The Control Panel appears.

As the run proceeds, status messages appear in the Control Panel. It takes about
a minute for Aspen Plus to process input specifications and perform the
simulation. When the calculations finish, the message Results Available appears
in the status bar at the bottom of the main window.

➤ Use the vertical scroll bar to the right of the Control panel window to see the
messages.

➤ When the Results Available message appears in the toolbar, click the Close button to
close the Control Panel window.

➤ Click the Close button to close the Data Browser.

You can now examine the results of your run.
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Examining Simulation Results
This run produces a wide variety of simulation results. In this session, you will
examine:

• Furnace duty
• Pumparound return temperatures
• Stream results for the atmospheric tower products
• ASTM curves for the tower products

Furnace duty results appear on the CRUDE Results Summary Furnace sheet. To
examine these results:

➤ Select the CRUDE block by clicking on the CRUDE icon.

➤ Press or click the right mouse button to display the Block menu.

➤ Select Results.

  The Blocks CRUDE Results Summary form appears.

➤ Click the Furnace tab.

  A summary of important Furnace results appears:
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To examine pumparound return temperatures:

➤ In the Data Browser, click the Pumparounds folder for CRUDE.

➤ Click the Results tab.

  The Pumparounds Results sheet appears:
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Examining the Product Streams
To review the stream results for the crude tower products:

➤ In the Data Browser, click the Stream Results form for CRUDE.

  The Blocks CRUDE Stream Results Material sheet appears.

To examine the results for the five product streams:

➤ Click the first Streams field, then select HNAPHTHA.

➤ In the next four Streams fields, select KEROSENE, DIESEL, AGO, and RED-CRD.

To examine the 5% and 95% cutpoints and product yields:

➤ Using the scrollbar, scroll down until  *** Dry Total*** is the top line displayed.

From these results, you can see that the tower produces a large quantity of the
diesel cut. By specifying a high ASTM 95% temperature (375 F), you also
maximize the amount of heavy naphtha produced.
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Stream results for the crude tower products appear on the Blocks CRUDE
Stream Results Material sheet:

➤ Scroll through this form to examine stream information for different products.
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Plotting Distillation Curves
Next, you will examine and plot the ASTM curves for the products. The ASTM
curves are on the Stream Results Vol.% Curves sheet. To plot the curves for the
product streams:

➤ In the Data Browser, click the CRUDE Stream Results form.

  The Stream Results form is revealed.

➤ Click the Vol.% Curves tab.

  The Stream Results Vol.% Curves sheet is displayed.

➤ Click the arrow to the right of the Curve view box, and select ASTM D86.

➤ Select the Volume % column label to select the column.

➤ From the Plot menu, select X-Axis Variable.

➤ Click the HNAPTHA column label to select the column.

➤ Move the mouse to the RED-CRD column. Shift-Click on the column label to select the
HNAPTHA column, the RED-CRD column, and all of the columns in between,
KEROSENE, DIESEL, and AGO.

➤ From the Aspen Plus Plot menu, select Y-Axis Variable.

➤ From the Plot menu, select Display Plot.
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  The ASTM curves should appear as shown:

➤ When you finish viewing this plot, close the Plot window.
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At this point, you can simulate other modes of operation, such as maximizing
kerosene production to satisfy a higher demand for jet fuel. You can do this by:

• Decreasing the ASTM 95% temperature for heavy naphtha to 325 F
• Increasing the ASTM 95% temperature for kerosene to about 520 F
• Introduce another design specification by manipulating the kerosene flow

rate

The product flow rates resulting from these specifications are:

ASTM-D86
5% Temperature F

ASTM-D86
95% Temperature F

Product Flow-Rate
(m bbl/day)

HNAPHTHA 166 325 4.7

KEROSENE 374 520 20.0

DIESEL 502 640 10.9

AGO 578 772 8.5

RED-CRD 674 1358 35.6

The results show that the kerosene production goes up at the expense of heavy
naphtha and diesel.
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Exiting Aspen Plus

To exit Aspen Plus:

➤ From the File menu, select Exit.

  A dialog box asks if you want to save your simulation.

➤ Select Yes to save the simulation.

  A dialog box asks if you also want to save the simulation as an Aspen Plus Document
file.

➤ Click No.

This run will be used as the starting point for the session in Chapter 4.

❖ ❖    ❖    ❖
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4 Adding A Vacuum Unit

In this session, you will build on the simulation from the previous session and
install a vacuum unit to complete the process model.

You will:

• Add a vacuum tower, steam feed, and product streams to the flowsheet
• Specify the steam feed
• Specify the vacuum unit
• Run the simulation
• Examine the results

Allow about 30 minutes to complete this session.
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Vacuum Unit Flowsheet

Figure 4.1 shows the process flowsheet for this session. It contains a vacuum unit
that separates the reduced crude from the atmospheric tower into:

• Off-gas
• Light vacuum gas oil
• Heavy vacuum gas oil
• Residual vacuum oil

Figure 4.1 Process Flowsheet Adding a Vacuum Unit

The vacuum tower has no condenser or reboiler. Stripping steam is fed to the
bottom of the tower. The following table shows the steam flow rate and
conditions:

Stream Location Conditions and Flow

VDU-STM Bottom of main fractionator 400 F, 60 psia, 20,000 lb/hr

The furnace operates at a pressure of 2.03 psia, and provides an overflash of
0.6%. The overflash is bypassed to the tower furnace.
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The tower has two pumparound circuits. The following table shows their
locations and specifications:

Pumparound Location Specifications

1 From stage 2 to 1 Flow:  20,000 bbl/day    Duty:  -28 MMBtu/hr (estimated)

2 From stage 4 to 3 Flow:  49,000 bbl/day    Duty:  -80 MMBtu/hr

The duty for the first pumparound is adjusted so that the top of the tower is at
150 F.

You will model the tower with six equilibrium stages. The light vacuum gas oil is
taken out from stage 2 as a total draw. The flow is estimated at 8,000 bbl/day.

The second pumparound provides all the necessary reflux for the lower section of
the tower. The heavy vacuum gas oil is withdrawn from stage 4 at 17,000
bbl/day.
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Starting Aspen Plus

To start Aspen Plus:

➤ Use the Windows Start menu, or double-click the Aspen Plus icon on your desktop.

Note If the Connect Host dialog box appears, see Appendix A.

  The Aspen Plus Startup dialog box appears.
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Opening an Existing Run
If you saved the crude flowsheet simulation created in Chapter 3:

➤ In the Aspen Plus Startup dialog box, select Open an Existing Simulation.

If your saved file crude.bkp appears in the list box:

➤ Select crude.bkp from the list and click OK.

If your saved file crude.bkp does not appear in the list box:

➤ Double-click on More Files… in the list box.

  The Open dialog box appears.

➤ Navigate to the directory that contains your saved file crude.bkp.

➤ Select crude.bkp from the list of files and click Open.

Note If the Connect to Engine dialog box appears, see Appendix A.

  The Aspen Plus main window appears.

If you did not create the crude distillation simulation in Chapter 3, you can open
the backup file crude.bkp in the Examples folder.

➤ From the Aspen Plus Startup dialog box, select Open an Existing Simulation. Click
OK.

  The Open dialog box appears.

➤ Click the Look in Favorites button .

  By default, the Favorites list contains five folders that are provided with Aspen Plus.

➤ Double-click the Examples folder.

➤ Select crude.bkp and click Open.

Note If the Connect to Engine dialog box appears, see Appendix A.

  The Aspen Plus main window appears.
  Aspen Plus displays the graphical flowsheet for the CRUDE run.
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Saving a Run Under a New Name
Before you create a new run adding the vacuum unit, you will create and save a
copy of CRUDE with a new Run ID, VACUUM. Then you can make modifications
under this new Run ID.

➤ From the File menu, click Save As.

  The Save As dialog box appears.

➤ Choose the directory where you want to save the simulation.

➤ In the Filename box, enter the new filename VACUUM.

➤ From the Save as Type list, select Aspen Plus Backup Files (*.bkp).

➤ Click Save to save the simulation and continue.

  A dialog box asks if you also want to save the simulation as an Aspen Plus Document
file.

➤ Click No.

  The current run ID, VACUUM, now appears in the titlebar.

To update the title for this run:

➤ From the Data menu, select Setup.

  The Setup Specifications form appears.

➤ Change the simulation title to Getting Started with Petroleum-Session 4.

➤ Close the window.

The graphics workspace is now active and ready for you to add to the existing
flowsheet.



Modeling Petroleum Processes 4-7
Version 10.1-0

Chapter 4

Adding a Vacuum Tower to the Flowsheet
You are ready to add the vacuum tower and steam feed to the flowsheet. To make
space for the new tower:

➤ From the View menu, select Zoom Out.

➤ Drag a region around the entire flowsheet.

➤ Press and hold the left mouse button within the region and drag the flowsheet to the
left, as shown in Figure 4.2.

Next, you will place and connect the vacuum unit on the flowsheet to create the
process flowsheet in Figure 4.2. If you need to review how to create a graphical
simulation flowsheet, see Getting Started Building and Running a Process Model,
Chapter 2.

Figure 4.2 The Vacuum Unit
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To place and connect the distillation unit on the flowsheet:

➤ Click the Column tab in the Model Library.

➤ Select the unit operation model, PetroFrac, to place in your process flowsheet.

➤ Click the down arrow next to the PetroFrac block icon to display all the icons available
for the PetroFrac model.

➤ Move the mouse over the icons to see a name (or label) for each.

In this exercise, you will select the PetroFrac icon VACUUM1F.

➤ Click and hold down the mouse button on the PetroFrac icon CDU10F, and drag it to
the Process Flowsheet window. Release the mouse button when it is in the desired
location.

➤ Place the VACUMM1F icon in the flowsheet, as shown in Figure 4.2. Name the block
VDU.

➤ To increase the size of the icon, hold down the Shift key, then press the + key.

➤ Connect, move, and name the streams, as shown in Figure 4.2, using the port
information below for guidance.

Stream ID Port Name

RED-CRD Main Column Feed

VDU-STM Main Column Feed

OFF-GAS Vapor Distillate from Main Column

LVGO Side Product from Main Column

HVGO Side Product from Main Column

RESIDUE Bottoms Product from Main Column

  

➤ Click the Next button.

  The Flowsheet complete dialog box appears.

➤ Click OK.

  The Input form for stream VDU-STM appears.
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Specifying the Steam Feed
Use the Input form for stream VDU-STEAM to specify the steam feed to the
main column.

➤ Enter, or use List to select, the following stream conditions. (Be sure to check the
prompts to see which fields are List fields.):

Temp 400 F
Pres 60 PSI
Composition Basis Mass-Flow LB/HR
H2O Flow value 20000 LB/HR

The Input form for VDU-STM is complete:

➤ Click the Next button.

  The Blocks VDU Setup Configuration sheet appears.
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Specifying the Vacuum Unit

Use the Blocks VDU Setup form to specify the main column configuration.

➤ On the Configuration sheet, specify:

Number of stages 6
Condenser None-Top pumparound
Reboiler None-Bottom feed

➤ Click the Next button.

  The Setup Streams sheet appears.

➤ Enter the following feed locations and connections:

State Convention

RED-CRD 6 Furnace

VDU-STM 6 On-Stage

The Furnace feed convention attaches a furnace to stage 6. This furnace is solved
simultaneously with the vacuum tower.

➤ Enter the following product location, phase, and rate specifications:

Stage Phase Flow

LVGO 2 Total liquid 8000 bbl/day (estimate)

HVGO 4 Liquid 17000 bbl/day

LVGO is a total liquid draw from stage 2. The flow rate you enter is an estimate
only.
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The Setup Streams sheet is complete:

➤ Click the Next button.

  The Setup Pressure sheet appears.

➤ Click the View field and select Pressure profile.

You will specify the pressure profile by entering stage numbers and
corresponding pressures on this form.

➤ In the Pressure profile section of this form, change the pressure units to mmHg.

➤ Enter the following values:

Stage 1 Pressure 60 mmHg
Stage 6 Pressure 70 mmHg

The Setup Pressure sheet is complete.

➤ Click the Next button.

  The Setup Furnace sheet appears.
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➤ Select the Single Stage Flash with liquid runback as the Furnace type.

➤ Specify a StdVol Fractional overflash of 0.006 and a Furnace pressure of 2.03 psi.

The single stage flash with liquid runback option models the furnace as a single-
stage flash with the overflash from the flash zone now bypassed to the furnace.

The Setup Furnace sheet is complete:

➤ Click the Next button.

  The Pumparounds Object Manager appears.

➤ Select New.

➤ In the dialog box, click OK to accept the default ID P-1.
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  The Blocks VDU Pumparounds P-1 form appears.

➤ To specify P-1, enter, or use List to select, the following specifications:

Draw stage 2
Return stage 1
Drawoff type Partial
StdVol Flow 20000 bbl/day
Heat duty -28.6 MMBtu/hr

The Pumparounds P-1 form is complete:

➤ In the Data Browser window, click the Pumparounds folder.

  The Pumparound Object Manager appears.

➤ Select New.

➤ In the dialog box, click OK to accept the default ID P-2.
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➤ Enter, or use List to select, the following specifications for P-2:

Draw stage 4
Return stage 3
Drawoff type Partial
StdVol Flow 49000 bbl/day
Heat duty -80.0 MMBtu/hr

The Pumparounds P-2 form is complete:

➤ Click the Next button.

  The Required Input Complete dialog box appears. 

You have completed all required PetroFrac specifications. However, in this
session you have a design specification–the temperature specification for the top
of the tower.

➤ Click Cancel.

➤ Click the Blocks VDU Design Specs folder.

  The Design Specs Object manager appears.

➤ Click New.
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➤ In the dialog box, click OK to accept the default ID 1.

  The Blocks VDU Design Specs 1 Specifications sheet appears.

➤ Enter, or use List to select, the following specifications:

Type Stage temperature
Target 150
Stage 1

➤ Click Next.

  The Blocks VDU Design Specs 1 Vary sheet appears.

➤ Click on the arrow to the right of the Type box, and select Pumparound duty from the
list.

➤ Select P-1 as the Pumparound name.

The design specification is complete.

➤ Close the window.

You have entered all the specifications for the vacuum unit.

➤ Close the Data Browser window.

➤ In the Aspen Plus main window, click the Next button.
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Running the Simulation

To run the simulation:

➤ In the Required Input Complete dialog box, click OK.

  The Control Panel appears.

As the run proceeds, status messages appear in the Control Panel. It takes about
a minute for Aspen Plus to process input specifications and perform the
simulation. When the calculations finish, the message Results Available in the
status bar at the bottom of the main window.

➤ Use the vertical scroll bar to the right of the Control panel window to see the
messages.

➤ When the Results Available message appears in the toolbar, click the Close button to
close the Control Panel window.

You can now examine the results of your run.
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Examining Simulation Results

This run produces a wide variety of simulation results. You will examine
simulation results for the vacuum tower that include:

• Column profiles
• Pumparound results
• TBP curves
• Stream results

Column profiles are on the VDU Profiles sheet. To examine column profiles:

➤ Click the VDU block icon to select it.

➤ Press or click the right mouse button to display the Block menu.

➤ Select Results.

  The Blocks VDU Results Summary form appears on the screen.

➤ Click the Profiles form in the Data Browser.
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This form shows that the simulation calculated a bottom temperature above 790
F. If this is higher than you want, you can reduce the tower pressure in a later
simulation case. Lowering the tower pressure also affects the gas oil yield.

The pumparound results are on the VDU Pumparound Results sheet. To examine
these results:

➤ In the Data Browser, click the Pumparounds folder.

➤ Click the Results tab.

  The Pumparounds Results sheet appears, displaying pumparound results:

➤ Close the window.
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Plotting Distillation Curves
Next you will plot the TBP curve for streams LVGO, HVGO, and RESIDUE. The
True Boiling Point curves appear on the Stream Results Vol.% Curves sheet. To
plot TBP curves:

➤ In the Data Browser, click the VDU Stream Results form.

  The Stream Results form is revealed.

➤ Click the Vol.% Curves tab.

  The Stream Results Vol.% Curves sheet is displayed.

➤ Plot the ASTM curves for streams LVGO, HVGO, and RESIDUE following the same
steps as in Chapter 3, Plotting Distillation Curves.

The simulation shows a good separation between the gas oils and residue.
However, the separation between the light and heavy gas oils is rather sloppy.

➤ Close the Plot window.
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Examining Stream Results

Next, you will review the stream results.

➤ Click the Material tab.

➤ Click the horizontal scrolling arrow at the bottom left of the form until the RESIDUE
stream appears.

➤ Click the scrolling arrow at the bottom right of the form to scroll through the form and
examine the results for the RESIDUE stream.

You can review the calculated flows and properties of the stream.

➤ To examine the calculated API gravity for this stream, click the scrolling arrow at the
bottom left of this form until the API Gravity row appears.

➤ Click the horizontal scrolling arrow at the bottom left of the form until the LVGO stream
appears.

The calculated value for LVGO product rate is different from the specified value
of 8000 bbl/day. Since you specified a total draw, Aspen Plus treated the specified
value as an initial guess. The final value is the one corresponding to the total
draw from the stage.
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Exiting Aspen Plus

To exit Aspen Plus:

➤ From the File menu, select Exit.

  Aspen Plus displays a dialog box asking if you want to save your simulation.

➤ In the dialog box, select Yes to save the simulation.

  A dialog box asks if you also want to save the simulation as an Aspen Plus Document
file.

➤ Click No.

This run will be used as the starting point for the session in Chapter 5.

❖ ❖    ❖    ❖
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5 Displaying Petroleum
Stream Properties

It is important to monitor certain petroleum properties such as sulfur content,
PNA composition, octane number, flash point, metals content, and pour point
when modeling refinery operations. Frequently, operating parameters are
adjusted in order to achieve a desired product quality, expressed in terms of
these petroleum properties.

These properties are often available as part of the assay data for a crude feed.
Aspen Plus enables you to enter these data as property curves. Once you enter
these curves, Aspen Plus can calculate these properties for any flowsheet stream.

You can use the calculated stream properties as column specifications, access
them in Fortran blocks, use them in optimization constraints, and so on.

In this session, as an example, you will include sulfur content in your model.

You will:

• Add a sulfur curve for each of the two crude oils
• Select options for the property sulfur
• Define a property set for the sulfur content
• Run the simulation
• Examine simulation results

Allow about 30 minutes to complete this session.
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Starting Aspen Plus

To start Aspen Plus:

➤ Use the Windows Start menu, or double-click the Aspen Plus icon on your desktop.

Note If the Connect Host dialog box appears, see Appendix A.

  The Aspen Plus Startup dialog box appears.
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Opening an Existing Run
If you saved the crude flowsheet simulation created in Chapter 4:

➤ In the Aspen Plus Startup dialog box, select Open an Existing Simulation.

If your saved file vacuum.bkp appears in the list box:

➤ Select vacuum.bkp from the list and click OK.

If your saved file vacuum.bkp does not appear in the list box:

➤ Double-click on More Files… in the list box.

  The Open dialog box appears.

➤ Navigate to the directory containing your saved file vacuum.bkp.

➤ Select vacuum.bkp from the list of files and click Open.

Note If the Connect to Engine dialog box appears, see Appendix A.

  The Aspen Plus main window appears.

If you did not create the vacuum unit simulation in Chapter 4, you can open the
backup file vacuum.bkp in the Examples folder.

➤ From the Aspen Plus Startup dialog box, select Open an Existing Simulation, then
click OK.

  The Open dialog box appears.

➤ Click the Look in Favorites button .

  By default, the Favorites list contains five folders that are provided with Aspen Plus.

➤ Double-click the Examples folder.

➤ Select vacuum.bkp and click Open.

Note If the Connect to Engine dialog box appears, see Appendix A.

  The Aspen Plus main window appears.
  Aspen Plus displays the graphical flowsheet for the VACUUM run.
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Saving a Run Under a New Name
Before you create a new run adding sulfur content specifications, you will create
and save a copy of VACUUM with a new Run ID, PPROP. Then you can make
modifications under this new Run ID.

➤ From the File menu, click Save As.

  The Save As dialog box appears.

➤ Choose the directory where you want to save the simulation.

➤ In the Filename box, enter the new filename PPROP.

➤ From the Save as Type list, select Aspen Plus Backup Files (*.bkp).

➤ Click Save to save the simulation and continue.

  A dialog box asks if you also want to save the simulation as an Aspen Plus Document
file.

➤ Click No.

  The current run ID, PPROP, now appears in the titlebar.

To update the title for this run:

➤ From the Data menu, select Setup.

  The Setup Specifications form appears.

➤ Change the simulation title to Getting Started with Petroleum-Session 5.

➤ Close the window.
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Adding Sulfur Content Data
In Chapter 1 you defined and blended two crude oils, OIL-1 and OIL-2. Now you
will enter the sulfur content (in weight percent) of these oils into your simulation.

➤ From the Data menu, select Components.

  The Assay/Blend and the Petro Characterization folders are revealed.

➤ Expand the Assay/Blend folder.

  The folders for the blend, MIXOIL, and the two assays, OIL-1 and OIL-2, that were
created are revealed.

➤ Expand the OIL-1 folder.

  The Basic Data, Property Curves, and Results form are revealed.

➤ Click on the Property Curves form.

  The Assay/Blend Property Curves form for OIL-1 appears.

➤ Click the Property type field, and select SULFUR from the list.

➤ In the Bulk value field, enter 2.3.

➤ In the Mid percent distilled and Property value fields, enter the following sulfur content
percentage values for OIL-1:

Mid percent distilled Property value (wt% sulfur)

2.0 0.0

5.0 0.01

10.0 0.013

20.0 0.05

30.0 1.15

40.0 1.62

45.0 1.90

50.0 2.15

Continued
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Mid percent distilled Property value (wt% sulfur)

60.0 2.54

70.0 3.0

80.0 3.7

The Assay/Blend Property Curves form for OIL-1 is complete:

To add sulfur content percentages for OIL-2:

➤ In the Data Browser, expand the OIL-2 folder.

  The Basic Data, Property Curves, and Results form are revealed.

➤ Click the Property Curves form.

  The Assay/Blend Property Curves form for OIL-2 appears.

➤ Click the Property type field, and select SULFUR from the list.

➤ In the Bulk value field, enter 2.5.

➤ Enter the following sulfur content percentage values for OIL-2:
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Mid-Pct Prop. Value

2.0 0.0

5.0 0.01

10.0 0.015

20.0 0.056

30.0 1.3

40.0 1.7

45.0 2.0

50.0 2.3

60.0 2.7

70.0 3.2

80.0 3.8

The Assay/Blend Property Curves form for OIL-2 is complete.
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Selecting Options for the Sulfur Property
For a petroleum property, you can select calculation options such as the blending
and extrapolation methods.

Now you will select options for the sulfur property.

➤ In the Data Browser, expand the Petro Characterization folder.

  The Generation and Property Methods folders, and Analysis Options and Results
forms are revealed.

➤ Click the Analysis Options form.

➤ Click the Blend Options tab.

  The Components Petro Characterization Analysis Options Blend Options sheet
appears.

➤ Enter the following data for the Property and Blend method fields:

Property SULFUR
Blend Method Mass

By default, Aspen Plus will extrapolate to the 0 and 100% points, if these values
are missing from the curve.

The Petro Characterization Analysis Options form is complete:
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➤ Close the Data Browser window.
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Adding the Sulfur Property
In order to include in the report the sulfur property you just defined, you must
create a Property Set.

➤ From the Data menu, select Properties.

➤ Click the Prop-Sets folder.

  The Prop-Sets Object Manager appears.

➤ Select New.

➤ In the dialog box, click OK to accept the default name, PS-1.

➤ Click OK.

➤ Click the Search button.

➤ In the Search Physical Properties dialog box, type Sulfur in the field and click the
Search button.

➤ Select Sulfur content from the list of Physical property names.

➤ Click the Add button.

➤ Click OK.
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  SULFUR now appears as a selected Physical Property on the Prop-Set form.

➤ Click the Qualifiers tab.
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➤ In the Water basis field, select Dry from the list.

The Properties Prop-Sets PS-1 form is complete:

➤ Close the Data Browser window.

Now you will add the SULFUR Property Set to the stream property list.

➤ From the Data menu, expand the Setup folder.

➤ Click the Report Options form.

➤ Click the Stream tab.

  The Setup Report Options Stream sheet appears.

➤ Click the Property Sets button.

➤ Move PS-1 from the Available property sets area to the Selected property sets area
using the > button.
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➤ Click the Close button.

The Report Options form is now complete.

➤ Close the Data Browser window.

➤ In the Aspen Plus main window, click the Next button.
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Running the Simulation

To run the simulation:

➤ In the Required Input Complete dialog box, click OK.

  The Control Panel appears.

As the run proceeds, status messages appear in the Control Panel. It takes about
a minute for Aspen Plus to process input specifications and perform the
simulation. When the calculations finish, the message Results Available appears
in the status bar at the bottom of the main window.

➤ Use the vertical scroll bar to the right of the Control panel window to see the
messages.

You can now examine the results of your run.
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Examining Results
To review the stream results for the crude tower products:

➤ Click the Check Results button  on the Control Panel.

  The Results Summary Run-Status form appears and indicates that the calculations
were completed normally.

To examine the stream results:

➤ Click the first Results Summary Streams form.

  The Blocks Results Summary Streams Material sheet appears.

To examine the results for the five product streams:

➤ Click the first Streams field, select HNAPHTHA.

➤ In the next four Streams fields, select KEROSENE, DIESEL, AGO, and RED-CRD.

➤ Click the vertical scroll bar until you reach the SULFUR results.

  The Results Summary Streams form displays sulfur content:
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As expected, the sulfur content of the heavier products, such as RED-CRD, is
higher than the sulfur content for the lighter products, such as HNAPHTHA. By
following the same procedure described in this section, you can incorporate other
petroleum stream properties into your model and track their distribution
throughout the flowsheet.
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Leaving Aspen Plus

To exit Aspen Plus:

➤ From the File menu, select Exit.

  A dialog box asks if you want to save your simulation.

➤ Select Yes to save the simulation.

  A dialog box asks if you also want to save the simulation as an Aspen Plus Document
file.

➤ Click No

❖ ❖    ❖    ❖
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A Connecting to the
Aspen Plus Simulation
Engine

If either of the following conditions exist, you will be prompted to specify the host
computer for the Aspen Plus simulation engine after you start the Aspen Plus
User Interface:
• The simulation engine is not installed on your PC.
• The simulation engine is installed on your PC, but the Activator security

device is not connected to your PC.

In these cases, the Connect to Engine dialog box appears.

➤ Click the Server Type list box and select the type of host computer for the simulation
engine.

If you choose Local PC as the server for the simulation engine, you do not need to
enter any more information into the dialog box.

➤ Click OK to continue.

If you choose UNIX host, OpenVMS host, or Windows NT server as the server for
the simulation engine:

➤ Enter the node name of the computer on which the Aspen Plus simulation engine will
execute.

➤ Enter your User Name, Password, and Working Directory, and click OK.

  When the network connection is established, a message box appears saying
Connection Established.
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If the Connection Established message does not appear, see your Aspen Plus
system administrator for more information on network protocols and host
computers for the Aspen Plus simulation engine.

❖    ❖    ❖    ❖
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